
 SafeBoot Help Contents
SafeBoot    is a Windows application you can use to safeguard your critical Windows boot files. 
The application can be run manually from its icon, or automatically when Windows boots. It was
designed primarily to run each time Windows boots to insure that the most recent working copies
of all critical files are saved. You may also want to save an archive set of files to a different 
directory or a floppy disk just to be sure you always have a safe working set. For more 
information about configuring SafeBoot    for automatic operation, see the Configuration Screen 
Overview below.

The Contents lists Help topics available for SafeBoot . Use the scroll bars to see entries not 
currently visible in the Help window.

To learn how to use help, press F1 or choose How to Use Help from the Help menu.

The majority of help available in this system is based on Hyper graphics. This means you can 
click on an area of the displayed picture and a pop-up window with an explanation will be 
displayed. Context sensitive help is also available while using SafeBoot . Just highlight a button 
or another control and press F1.
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 If you have any questions or problems with SafeBoot feel free to contact Lake Forest 
Software at 7117 Mowhawa Drive, Fort Wayne, Indiana    46815. If you are an America OnLine 
member you may send E-Mail to LakeForest. If you are a member of Compuserve you may send 
E-Mail to 74361,22. Internet: 74361.22@compuserve.com 
Thank You.



 Lake Forest Software License Agreement
This is a legal agreement between you (either an individual or an entity) and Lake Forest Software. By using this software
you are agreeing to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, promptly 
return the software diskette to Lake Forest Software for a full refund.

1. GRANT OF LICENSE. This License Agreement permits you to use one copy of the enclosed Lake Forest Software software 
program (the "SOFTWARE") on a single computer. The SOFTWARE is in use on a computer when it is loaded into temporary 
memory (i.e., RAM) or installed into permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer. 
However, installation on a network server for the sole purpose of internal distribution shall not constitute "use" for which a 
separate license is required, provided that you have a separate license for each computer to which the SOFTWARE is distributed.

2. COPYRIGHT. The SOFTWARE is owned by Lake Forest Software and is protected by United States copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or 
musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or 
(b) transfer the software to a single hard disk provided you keep the original solely for backup or archival purposes.

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE on a permanent 
basis provided you retain no copies and the recipient agrees to the terms of this Agreement. You may not reverse engineer, 
decompile, or disassemble the SOFTWARE. If the SOFTWARE is an update or has been updated, any transfer must include the 
most recent update and all prior versions.



 An Introduction to SafeBoot
SafeBoot    provides an easy way to perform regular backups of Windows' most critical 
configuration files. If you've ever booted your computer only to find out one of these files has 
been lost or corrupted, you'll be glad you're using SafeBoot .

While SafeBoot isn't a substitute for full backups of your hard disk, it can provide a quick and 
easy way to restore damaged files. It can save you a lot of time over swapping floppy disks or 
restoring a backup tape, since all of the files can be backed up to one of your hard disks.

If you are a novice with computers, SafeBoot can provide a level of protection that will allow 
you to experiment with different settings for Windows. You won't have to worry about totally 
screwing something up and not know how to fix it.

If you are an expert with computers, you can feel free to dig into WIN.INI, SYSTEM.INI, 
CONFIG.SYS and other files to performance tune your system. If you step over the line, just 
restore the files from the last time you got it right.



 SafeBoot Configuration Screen
This screen is used to configure SafeBoot for operation. It can be used to customize SafeBoot to 
work the way you would like it to.

Click on various parts of the screen below for more detailed information.

See Also: Filter Screen Overview
Main Screen Overview
Scan Screen Overview



 SafeBoot Main Screen
The main screen of SafeBoot is where you will spend most of your time when you want to use 
the application in manual mode.

Click on various parts of the screen below for more detailed information.

See Also: Filter Screen Overview
Configuration Screen Overview
Scan Screen Overview



 SafeBoot Scan Screen
The scan screen can be used to add files from directories other than your Windows directory to 
the backup list.

Click on various parts of the screen below for more detailed information.

See Also: Filter Screen Overview
Configuration Screen Overview
Main Screen Overview



 SafeBoot Filter Screen
The filter screen is used to limit the files presented in various lists based on the file's 3 character 
extension.

Click on various parts of the screen below for more detailed information.

See Also: Main Screen Overview
Configuration Screen Overview
Scan Screen Overview



 Database Repair
Hopefully, you will never have to use this procedure. If your system hangs, you have a power 
outage, or just because, the database that SafeBoot uses can become corrupted. If SafeBoot 
detects this condition at startup it will display a message describing the above condition. When 
you click OK, SafeBoot will attempt to automatically repair the database. This will normally be a
successful procedure, but given that anything can happen at least once, here's how to fix it if the 
automatic procedure fails.

Rename SAFEBOOT.INI in your windows directory to SAFEBOOT.SAV
ex. CD \WINDOWS

RENAME SAFEBOOT.INI SAFEBOOT.SAV

Delete the 2 database files in the SafeBoot installation directory
ex. CD \SAFEBOOT

DEL SB20FLST.*

Run SafeBoot again. You will need to go through the configuration routine.

Copy back SAFEBOOT.SAV to SAFEBOOT.INI. This will restore any filters and other 
settings you might have made.

ex. CD \WINDOWS
COPY SAFEBOOT.SAV SAFEBOOT.INI

See Also: Configuration Screen Overview



 Background Information
Lake Forest Software came into being due to the desire for inexpensive and high quality 
software. Although Lake Forest Software has only been in existence for a short period of time, I 
(the priciple owner and programmer) have been in the data processing business for almost 15 
years. 

I received a BS in Computer Science way back in 1980. I've done programming and analysis 
work on PCs (since 1981, before they were fashionable), midrange (nice platform), and 
mainframe (they make great file servers) computers. I'm now close to completing an MBA 
degree, so I thought I would start a small company to try my hand at big business.

I've chosen Visual Basic 3.0 to write SafeBoot because of the inherent power of the language and
it's ease of use. The development life cycle is surprising short, due in part to the excellent 
facilities provided in the Visual Basic development environment. I've decided however, to write 
SafeBoot Version 3.0 in Visual C++ for reduced processing time, no runtime DLLs, more control
over minute details, and it looks like a interesting language to learn.

SafeBoot Version 1.X was created in November, 1993 - January, 1994 in MS Visual Basic 3.0 
Standard Edition.

SafeBoot Version 2.0 was written from February - April, 1994 in MS Visual Basic 3.0 
Professional Edition.

SafeBoot Version 3.0 development will begin later in 1994 and will be written with MS Visual 
C++ 1.5 Professional Edition. Look for it sometime in 1995.



Press this button when you have completed your selections.



This list shows you all of the files from your Windows directory that have not been selected for 
backup. If you remove files from the backup, they will also appear in this list even if they are not
from the Windows directory. This list may be filtered using one of the filter buttons below.

See Also: Selecting files from a list



 Selecting Files From A List
The conventions for multiple selection follow Windows standards. First, select the first file in the
list you want to move. Then using the mouse you can CTRL+Click on several non-contiguous 
files, or SHIFT+Click to select a contiguous block of files. For more information, see your 
Windows documentation.

Both lists on the main screen allow the multiple selection of files. This makes it easier to move a 
number of files from one list to the other without having to move them one at a time. 

You can now use the Add or Remove buttons on the main screen to move the files.

An alternate method of moving the files is to drag and drop the selection between the lists. This 
method is similar to Windows conventions for drag and drop with one exception. If you are 
moving multiple selections, you must continue to hold down the CTRL or SHIFT keys while 
performing the drag operation. Hopefully, this anomaly will be rectified when SafeBoot Version 
3.0 is written in Visual C++.



The Archive Directory area reflects where you have decided to keep a safe set of files. They will 
only be overwritten if you perform another Archive. This directory can be changed by the Set 
Archive button at the left.



Use this button to create a directory for backup or archiving. When pressed, a small input box 
will be displayed. The proper format for a directory name is XXXXXXXX or 
XXXXXXXX.XXX



This list displays all of the files in the selected directory that match the filter settings.

See Also: Filter Screen Overview



When this selection is checked, all DOS batch (command) files will appear in the list. The 
AUTOEXEC.BAT file is an example of this type of file.



When this selection is checked, all configuration files will appear in the list.



When this selection is checked, all Windows group files will appear in the list. Each group 
(Main, Accessories, Startup, etc.) has one of these files associated with it.



When this selection is checked, all initialization files will appear in the list. The WIN.INI and 
SYSTEM.INI files are examples of this type of file.



When this selection is checked, a small input box will be displayed where you may enter a 3 
character file extension of your choosing. Any files with the extension will appear in the list.



When this selection is checked, all DOS Program Information Files will appear in the list. These 
files help windows run DOS programs correctly. See PIF Editor in the Windows documentation 
for more information.



When this selection is checked, all system files will appear in the list. CONFIG.SYS is an 
example of this type of file.



Set the Auto Run option to automatically run SafeBoot each time Windows boots. Although not 
required, I would recommend setting Auto Scan as well.



Set the Auto Scan option to automatically add any new files in your Windows directory to the 
backup list. As you install new software, their initialization files will be picked up.



Click the Archive button to make a safe set of your files. The files will be saved to a floppy disk 
or another directory depending upon how you last set the archive directory on the configuration 
screen.

See Also: Selecting files from a list



Click the configure button to jump to the configuration screen. For more information about 
configuring SafeBoot, see Configuration Screen Overview

See Also: Configuration Screen Overview



First, select any file(s) you want to restore in the backup list. Then, click the Restore button to 
copy the saved file(s) over the lost or damaged file(s).

See Also: Selecting files from a list



First, select any file(s) you want to restore in the backup list. Then, click the Restore button to 
copy the saved file(s) over the lost or damaged file(s). This is similar to the Restore function 
except that it will copy the file from the specified Archive directory. If you've archived the files 
to a floppy, have it handy.

See Also: Selecting files from a list



These buttons control the movement of file(s) between the two lists. If you want to move all of 
the files from one list to the other, just click the All button. If you want to move one or more 
files, you must first select them in the list and click the Add or Remove buttons.



Click to Exit button to end SafeBoot.



The Installation Directory area reflects where SafeBoot was installed. You can not change this 
entry on the configuration screen.



First, use the Drive and Directory lists at the left to set a directory. If you want to Archive to a 
floppy disk, one must be in the drive. Then press Set Archive to establish the archive directory.



Use the Cancel button to cancel any changes you may have made to the settings.



Use these Drive and Directory lists to select the Backup and Archive directories. The directory 
must be double-clicked and appear to be "open" prior to setting them. Double check your settings
before you are done.



Set the Exit When Complete option to automatically exit from SafeBoot when a backup or 
restore operation is complete.



Set the Once A Day option to perform a backup only on the first boot of the day (usually when 
you turn the power on). Otherwise, each time Windows boots, SafeBoot will run.



First, use the Drive and Directory lists at the left to set a directory. If you want to Archive to a 
floppy disk, one must be in the drive. Then press Set Backup to establish the backup directory. 
This is where your files will be backed up to each time SafeBoot runs.



When you have completed you configuration changes, click Done to return to the Main screen.



The Backup Directory area reflects where you have decided to regularly save your files. They 
will be overwritten each time SafeBoot runs (typically each time Windows boots). This directory 
can be changed by the Set Backup button at the left.



Press the Backup button to perform a backup of all files in the backup list immediately.



Choose the Edit menu to start SysEdit, a Windows supplied INI editor.



Choose the File menu to perform various backup and restore funtions. These are also available 
through the button bar.



Choose the Help menu to get help on various functions. Use the About SafeBoot selection to get 
the version number among other things.



Press the Scan button to add files that are not in your Windows directory to the backup list.



Press the Done button when you are done adding files to the backup list and return to the main 
screen.



This status area will be updated with one-line help descriptions as you move your mouse over 
various areas of the screen.



After selecting files to be added to the backup list, press Add To List to add them.



Press Cancel to return to the main screen without adding any files to the backup list.



Press the Configure button to jump to the SafeBoot configuration screen.

See Also: Configuration Screen Overview



Press the Filter List button to include or exclude certain file types from the file list.

See Also: Filter Screen Overview



Press the Filter List button to include or exclude certain file types from the file list.

See Also: Filter Screen Overview



This status area reports the total of all file sizes in the backup list.



This status area displays the file name currently being processed in a backup or other operation.



This list area displays all of the files in the backup list. It can be filtered with the buttons below.

See Also: Filter Screen Overview
Selecting files from a list



Use these Drive and Directory lists to select the directory you want to select files from. The 
directory must be double-clicked and appear to be "open" prior to setting them. Any files will 
appear in the list at the left.

See Also: Selecting files from a list




